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Student Resource 7.1
K-W-L Chart: Word Processing
In the first column of the chart, write everything you know how to do using a word processing program like Microsoft Word. For example, you might write things like: Open a document, Print a document, Copy and paste. In the second column, write a list of things you’d like to learn how to do, or what you’d like to learn how to do better. For example, you might want to learn some shortcuts, or learn how to work with tables. During the reading about word processing, you might want to add new things to this column. Finally, use the third column to take notes on new things you learn to do with a word processor during this lesson.

	What I KNOW
	What Else I WANT to Know
	What I LEARNED

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


Student Resource 7.2
Reading: Introduction to Word Processing
What Is Word Processing? 
When someone mentions a word processor, what do you think of? Most of us think of software, like Microsoft Word. However, when the idea of word processing became widely known in the 1970s, it was seen mainly as a new way to organize work. Typists and transcriptionists used automatic typewriters in a central location. Electronic keyboards and software functions (formatting and spelling checkers) brought on faster typing speeds and sped up the production of documents. The automated office was born. 
Some of the tools of later word processors were already available in 1970. What was missing back then was a user-friendly interface. Even in 1970, features like scrolling, using a mouse to cut and paste, and find and replace tools were not unheard of. Some systems then were even more advanced than the ones that came out years later. The software could do advanced formatting, let users work with others on document editing, add graphics to documents, insert automatic numbering, send electronic messages, and make links between documents. 

This sounds a lot like what we’re familiar with today, but because what users saw on the screen was awkward and complicated, word processing did not advance very quickly. Think of where we would be today if a graphical user interface and technology had been paired almost 40 years ago!

Features and Benefits of Word Processing Programs
Over the last 15 years, many improvements have been made to help people work more productively and efficiently as they create consistent, professional-looking documents. This improved situation is largely due to advanced editing, formatting, and review tools. Being able to format and edit in seconds instead of days allows more work to be done by fewer people in less time. Increasing numbers of people now work remotely and efficiently on the same documents at the same time—even when they are in different cities around the world.
Some of the more advanced features of the Microsoft Word or Google word processing systems are: 
· Online document creation. Documents can be created on any Internet-connected computer. Any authorized person can edit and update a document simultaneously with other reviewers, all from their web browsers.

· Tracking and revision history. Each revision is automatically saved, and users can see who changed or added what, and when. It’s also possible to go back to an older version of the document at any point. 

· Preservation of formatting. Even when users are sharing documents, the formatting (e.g., font type, font size, etc.) stays the same. 

· Spelling and grammar checkers. Users can write like an English major thanks to customizable spelling and grammar hints and automatic substitutions and corrections.
· Shortcuts. Words in the toolbar have an underlined capital or lowercase letter—these are the letters that, when you press them along with the Ctrl button (or Apple key on a Mac), allow for a desired change without you having to look away from the screen or remove your hands from the keyboard. Some examples: 
· Ctrl+A to select all text 

· Ctrl+2 to double space 

· Ctrl+5 for 11/2 spaces 

· Ctrl+1 to return to single space 

· Ctrl+F to find text in a document

· Ctrl+C to copy

· Ctrl+V to paste

· Ctrl+Z to undo
· Repeat format (Format Painter) tool. In Microsoft Word, when you need to copy a format (e.g., font selection, bold, italic) to more than one place, just double-click the Format Painter button on the toolbar (the paint brush). 
· Header and footer. The header is at the top of a document, where the title usually appears. The footer is at the bottom of the page, where the page number and date are typically found. Within the View menu, Header and Footer allows you to add and modify repetitive content for clear, consistent, and professional-looking documents.

· Automatically linking the parts of a document. A document can be set up so that any change made within it automatically changes and updates the table of contents or other sections of the document. 
· Page formatting for printing. This feature allows you to modify and see pre-printing views for a wide variety of printer types. You can duplex print (on both sides of a piece of paper) and choose a different orientation (portrait/vertical or landscape/horizontal), etc.
· Style settings. It is possible to set document styles and formats, from font sizes and colors to spacing and bullets, and then modify large or small areas of content with a click within the Styles and Formatting window.
· Seamless application integration. Copy and paste or import any page of any Microsoft application (databases, spreadsheets, etc.) into Word. 
· Website creation. If you don’t have a web authoring tool, you can use Microsoft Word to create and update websites. 
Popular Word Processing Programs

Microsoft dominates the word processing market (as well as markets for other office productivity software), with a reported 500 million people using Word as part of their software libraries. However, other companies with competing word processing applications have been around for years and still hang on with a much smaller percentage of the market. Lotus and Corel (WordPerfect), while once larger competitors, are still around today. 
Even though people often work in collaborative environments and are sometimes paired with people in other offices around the world, confusion about document version control is fading because of Google’s web-based approach (there is no software to load). In addition, users have seen the benefit to open source applications such as Writer (by OpenOffice) and KWord. What is the benefit? The software is free.  

Considering how far word processing has come in a relatively short amount of time, where do you see the future of word processing in the next 5 years? Or even 20 years? Beyond?

Student Resource 7.3

Worksheet: Writing With Microsoft Word
Directions  

Follow the instructions on this worksheet to create a page in Microsoft Word that shows you have mastered setting page margins, creating bulleted and numbered lists, creating tables, using different styles, and using the spelling checker. Some of these items may be review for you. 
1. Open a new, blank Microsoft Word document.

2. Set the page margins to 1 inch on top, bottom, right, and left.

To edit the margins, click File from the menu bar, select Page Setup on the drop-down menu, and select the Margins tab in the window that opens. (In other words, go to File ( Page Setup ( Margins.) If you don’t see Page Setup on your file menu, click the down arrow at the bottom of the list to see all of the menu items.
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In the Margins window, change the value in each of the four boxes to 1". Click OK to confirm the changes. Note that this is also the window for page orientation. Make sure your document is using the Portrait orientation.
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3. Put the page number in a footer in the center bottom of the page.

On the Menu bar, select Insert ( Page Numbers. In the Page Numbers window, choose “Bottom of the page (Footer)” for position and choose “Center” for alignment. Click OK to confirm the changes. You can also click the Format button in this dialog box and see what options there are for the page numbers. The preview shows the location of the page numbers on the page.
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4. Put your name in the upper-right corner of the document.

Type your name on the first line of the document. Using the cursor, select your name, then click the Align Right button in the Formatting toolbar. If you can’t see the Formatting toolbar, select View ( Toolbars ( Formatting.
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5. Make “Word Processing” your document title. Use a Heading 1 style for the title, and make sure it is centered.

Type “Word Processing” on the next line of the document. Open the Styles and Formatting window by clicking the first button on the Formatting toolbar (the button with two capital A’s). Highlight the text you just wrote and select “Heading 1” from the list of formats. 
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If this doesn’t center the text, then the “Heading 1” style needs to be changed to have center alignment. Move your cursor over the “Formatting of selected text” box at the top of the Styles and Formatting window; a drop-down arrow will appear in the right side of the box. Click the arrow and select Modify from the shortcut menu that appears. 
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In the Modify Style window, you can change the font, font size, alignment, and other properties of the selected style. Choose center alignment and click OK to confirm the change. The title should now be centered on the page.
6. Use an Arial 10-point font (“Normal” style) for all other text in the document.

If Arial 10 is not the default font, then the “Normal” style needs to be changed. Click Modify for the “Normal” style the same way you did to center “Heading 1.” Change the font to Arial and choose 10 for the font size. Click OK to confirm the changes.
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7. Create a bulleted list of at least five different professional uses for word processing. Make the bullets looks like squares. 

Position your cursor in the document in the place where you want to start your list. On the menu bar, select Format ( Bullets and Numbering ( Bulleted. From the available options, choose a bulleted list style that uses square characters for the bullets, then click OK. After you are done creating your list, select the “Normal” style from the Styles and Formatting window to end the bulleted list.

8. Create a numbered list of the three most important reasons to become proficient in word processing. Under each numbered item, put an indented sentence to explain why this is important.

Position your cursor in the document in the place where you want to start your numbered list. On the Formatting toolbar, click the Numbering button to begin your numbered list. 

To make indented sentences under the numbered items, you need to use a different format. At the bottom of the Styles and Formatting window, choose “All styles” from the “Show:” list. This gives you a long list of different formats. Find the style “Normal Indent” and use it for the sentences under the numbered items. (Once you have used this feature to format one sentence, you can change the selection in the “Show:” box back to “Available formatting.”)
9. Create a two-column table. In the left column, put six words from your reading on word processing. In the right column, put short definitions of these words. Highlight any definitions you aren’t sure about in yellow. Use table headings for both columns. Then sort the column with the words to put them in alphabetical order.

To make the table, select Table ( Insert ( Table from the menu bar. This brings up the Insert Table window. You need a table with two columns and seven rows (one row for each of the six words, plus a row for the headings).
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After you have filled out the table, you can highlight definitions you are unsure of by selecting the text and clicking the Highlight button on the Formatting toolbar. Be sure that the color selected for highlighting is yellow. 

To alphabetize the table, place your cursor somewhere in the table and select Table ( Sort from the menu bar. In the window that appears, make sure you choose “(Column 1)” in the “Sort by” list and choose “Text” in the “Type:” list, and be sure to specify that your table has a header row so that its position isn’t changed. Click OK to confirm.
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10. Spell-check your document.

To spell-check your document, select Tools ( Spelling and Grammar from the menu bar. The spelling checker will display each potential problem it finds. You can click the Ignore button to leave the selection as-is, or select a suggested alternative and click Change to modify the text.

11. Check your document to make sure everything is correct. Then print it.

Select File ( Print to bring up the Print window. You can choose which printer to use (you may need to ask your teacher which printer you should use) and then press OK to print the document.

Exemplar: Word Processing Exercise

Your word processing page should look something like this:
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Student Resource 7.4

Reading: Introduction to Spreadsheets
What Is a Spreadsheet?
Imagine working at a company and being in charge of entering volumes of data, facts, and figures for multiple departments, product lines, or locations! You’d need to organize all the information into one place. Accountants and bookkeepers have always used spreadsheets with columns and rows, originally on paper, to record and organize financial information. Within a spreadsheet, categories typically run across the top in columns, while types of payments or expenses run down the left side, in rows. A figure or value is placed where a row and a column converge.

When people began to use computers to organize accounting and payroll data and to generate reports, electronic spreadsheets were developed to run within software applications. Using formulas, these spreadsheets help people quickly and accurately calculate numbers and other information. One of the first spreadsheet software programs was VisiCalc in the 1970s. Other programs developed and added presentation abilities. Similar to what happened with word processing, spreadsheet software became easier for people to use. 

How Do Spreadsheets Work?
All spreadsheets are basically grids of cells. Cells are the spaces where you can input different values. The columns of the grid are labeled across the top of the spreadsheet using letters, from A to Z, then AA to AZ, and so on. The rows are labeled along the left side using numbers. The most basic spreadsheet programs allow you to have at least 256 rows and columns, while more powerful programs increase this limit to the thousands.

Each cell in a spreadsheet has a cell address, which can be used to identify it. The cell address consists of its column and row labels—so, the cell address for the cell in the D column and 7th row would be D7. If you click in a cell, its address will be displayed in the cell address box, which is usually near the upper-left corner of the window.

You don’t have to select cells one at a time; you can also select a range of cells. You can define the range you want with the first and last cells of the range separated by a colon. Typing “B2:B8” in the cell address box will select the cells in the B column from the 2nd row to the 8th row. “F12:K20” will select all the cells in columns F to K from rows 12 to 20. You can also select all the cells in a column by clicking the column label at the top of the spreadsheet, and select all the cells in a row by clicking the row label.

With larger spreadsheets that have more than a few dozen rows or columns, not all the data will be able to fit on the screen. In these cases, the spreadsheet program is like a window that can be moved to look at the different parts of the spreadsheet.

Entering Data

Near the top of the screen, there should be a white box that stretches across the screen. This is the data entry box, where you can input data for the different cells. You can also type information directly in the cells on the spreadsheet. However, if your data is more than a few characters, you may find that the cells are too small to display everything you are trying to type. This is especially true for entering formulas, because they are longer, and you want to see the entire formula you are entering to be sure you haven’t made any mistakes.

A good method is to use both the grid and the data entry box. You can select the correct cell and begin entering data, making sure to look at the complete entry in the data entry box to check for correctness. 

Checking the data entry box is also important for checking the contents of the cell, as opposed to the value of the cell. For example, if you have a cell with =SUM(C3:C6) (which in some spreadsheet programs will add the values of the cells in column C, rows 3 to 6), then on the spreadsheet it will display a number—the sum of the values in that range. But the “=SUM(C3:C6)” will remain in the data entry box to remind you where the value that displays came from.

In addition to numbers, spreadsheet cells can contain text, dates, currencies, and more. You can use the spreadsheet program to change the format in which the numbers, currencies, or dates are displayed. You can also change a spreadsheet’s appearance by choosing different alignment for the contents of cells, changing font type and size, and using colored text or backgrounds. 

Popular Spreadsheet Programs

Spreadsheet programs are available within suites of office software, on their own, or both. After superseding VisiCalc, Lotus 1-2-3 and Quattro Pro took over the spreadsheet market, until Microsoft Excel took the lead position and held strong.   

OpenOffice.org’s Calc is an open-source alternative to Microsoft Excel. Calc can open Excel’s files and vice versa. There are also online spreadsheets, such as EditGrid and Google Docs and Spreadsheets.
Adapted from: GeekGirls Plain English Computing, http://www.geekgirls.com/spreadsheet02.htm
Student Resource 7.5

Research: Pricing Components for 
Your Dream Computer

Remember, you have a budget of $3,500 to spend on your dream computer. A spreadsheet is the perfect tool to help you keep track of each part of your computer and its cost. As part of your culminating project work, you will be creating a spreadsheet that lists the components of your dream computer along with the manufacturer and price of each component. By researching the prices of your components and creating a spreadsheet that keeps a running total of your expenses for you, you will be able to stay on target.

The first step is to do some research on the Internet to find prices for your components. Since you haven’t defined all of the things you need for your dream computer yet, you will be pricing only your peripherals in this exercise. Then you can add the other components to your spreadsheet as you go, because you will have the skills you need to do the research and work the spreadsheet.

Follow the instructions below to research prices for your peripherals on the web.

Online Research Tips

It is easy to look at prices for computer parts by going to online shopping sites. Most consumers buy prebuilt computers from companies like Dell or Hewlett-Packard. This is becoming even more popular, as these companies offer customization options for the computers they sell. But for your dream computer, you need to buy parts to make sure you get exactly what you need. There are websites that offer individual computer components, either for those intending to upgrade their computer or for those who are planning on building their own. By building your own computer, you can buy each specific part that you want, and you can save a lot of money. Of course, you need to know what you are doing, because the pile of computer parts won’t do anything useful until you put them together correctly.

Some sites that will probably be helpful for figuring out prices of computer parts are http://www.newegg.com and http://www.amazon.com. Newegg.com is an online electronics site. Since it specializes in tech products, you can probably find everything you need there for your computer, but it is still important to look elsewhere to see if you can find better deals. Amazon.com is a shopping site that sells many different types of products. Their selection includes computer hardware and peripherals. Some manufacturers, such as Nvidia, also sell their products directly from their official website. In addition to these websites, you can look for other online retailers, which may offer better deals.

Collecting the Data

1. In the first column of the table below, make a list of the peripherals you want to buy for your dream computer. 

2. Using the suggested websites, search for each of the peripherals and find at least two different options for each. 

3. In the second column, list the manufacturer.

4. In the third column, list the best price.

5. In the fourth column, list the highest price you find listed for the peripheral. This will remind you how much the part could cost.

When you have filled out all four columns, you have the information you need to create your spreadsheet in the next activity.

	Peripheral
	Manufacturer
	Best Price
	Highest Price

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	


Student Resource 7.6

Worksheet: Designing a Spreadsheet for 
Your Dream Computer
Now you can convert your itemized list of the parts of your dream computer into a spreadsheet that displays the name of each item, the best manufacturer, the best price you can find, the highest price you find, and the average price for the component. You can also have a column for comments to remind yourself about stuff you find in your research, such as the name of the site where you found the best price for each item. 

1. Open Excel and start working on a blank sheet. Save the document with a name related to your dream computer project so that you will be able to find this worksheet and continue to work on it throughout your project.

2. Create your spreadsheet with six columns labeled Part, Best Manufacturer, Lowest Price, Highest Price, Average Price, and Comments. We’ll enter the details for each part in a separate row under these columns.

Your spreadsheet will have column labels in cells A1 to F1 (remember cells are addressed by their column and row coordinates), thus:

A1: Part
B1: Best Manufacturer
C1: Lowest Price
D1: Highest Price
E1: Average Price
F1: Comments

Your spreadsheet should look something like this: 
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3. Use the data you collected in your research on prices for your dream computer peripherals. Enter the details for your first peripheral in the second row—that is, cells A2 to F2. Be sure to use the dollar sign with your prices. Leave the Average Price column blank; the spreadsheet program will calculate that price for you. Data for the second peripheral will go in cells A3 to F3; for the third peripheral in cells A4 to F4; and so on. When you’re entering data, you simply click in a cell to position the cursor, type the value into the cell, and then move to a new cell by using the arrow keys or (in most spreadsheets) by pressing the Tab key.

Your spreadsheet should look something like this:
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4. Now that you have the best price and the highest price for each peripheral, you could calculate the average price manually—but that's what your spreadsheet is for: doing the manual labor of calculating. So, instead of working out the value and typing it in the appropriate row in column D, insert a formula in column D instead of a value.

· Place the cursor in cell E2. This is the cell where you want to see the average price of your first peripheral. 

· From the Insert menu, select Function to display the Insert Function dialog box. 

· In the “Select a function” box, select “Average” and click OK. The Function Arguments dialog box displays.
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· In the “Number 1” box, you should see “C2:D2.” That means it will give you the average of the numbers in cell C2 and cell D2. That’s what you want, so click OK. 

· Now cell E2 displays the average price, and the data entry box above the spreadsheet displays the formula you used.

5. Suppose you hunt around a bit and find a lower price for this peripheral. What happens to the number in the Average Price cell if you change the value in the Best Price cell? Try it and see.

6. It is even easier to calculate the Average Price column for the peripherals in the other rows. Spreadsheet programs are made so that if you type in the first formula and then copy and paste it to new cells, the formula will update based on its new position.
· Using the cursor, select cell E2. Use the shortcut Ctrl+C to copy the value in that cell.

· Next, select all the cells in column E where you want to place average values.

· Use the shortcut Ctrl-V to paste into those cells the average formula that you copied.

Now each of the cells in the Average Price column should display the average price for the peripheral on that row. No matter how many different parts you are interested in buying, you can copy and paste the first formula into all of the later Average Price cells. The spreadsheet will do the busywork of utilizing the appropriate formula in each cell.
7. Finally, to complete your spreadsheet, you need to calculate some totals so that you know how much all of your peripherals will cost you.

In addition to giving you the option of inputting formulas instead of just values, spreadsheets have an automatic sum feature that adds ranges of cells for you. In Excel, there is an AutoSum button on the toolbar that looks like this: (. Click the cell where you want the total to appear, then click the AutoSum button. The program will guess which cells you want to add and highlight them. If it guessed correctly, you are already done; if not, it is a simple matter of redefining the range you would like added together.

On your spreadsheet, create a row entitled “Totals” in the row below your last peripheral. Then, in the D, E, and F columns of that row, use the AutoSum button to calculate the total value for each of the columns. 
 
When all of the values display, select that row of totals and make it bold, so that the total values stand out.
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8. As helpful as all the spreadsheet functions are, it is still easy to get disoriented in the maze of cell references. You need to pay close attention and check your work to ensure that your spreadsheet formulas perform the right actions on the correct range of cells. The best way to do this is called a “sanity check.” Look at the values in the different cells and make sure they make sense. For example, the average price should be somewhere between the best price and the highest price. The total price should look somewhere in the ballpark of what you would get if you added all the numbers in the column. Use this kind of reasoning to quickly check all of your values.

9. Finally, you need to print the spreadsheet so that you can hand it in for assessment. One tricky thing with spreadsheets is telling the printer which part of the spreadsheet you want it to print. You want to print only the area with your data in it, not all the empty cells that you can see. Here is how to define the right area for printing:

· On the View menu, click Page Break Preview. 

· Using your mouse, select the area you want to print. 
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· On the File menu, point to Print Area, then click Set Print Area. When you save the document, your print area selection is also saved. 
· On the File menu, select Print. In the Print dialog box, select the correct printer and print your spreadsheet.

10. Save this spreadsheet according to your teacher’s instructions, either on a hard drive or on a CD. You will need to have access to this spreadsheet so that you can continue to update it for your final project.

Student Resource 7.7
Worksheet: Database Defining Format 

Use the information you learn in the reading about databases to fill in the following chart. Your entries should have the same structure as the example in the first row. When you have completed the Defining Format entries, go on to answer the questions about the database displayed on the next page.

	Term
	Category
	Characteristics

	Table

	is a structure in a database that
	1. contains data.
2. is organized in rows and columns.
3. …



	Field
	
	

	Record

	
	

	Key

	
	

	Query

	
	


Below is a database table created using Microsoft Mail Merge.
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1. List the fields in this database:

2. How many records are in the database, and how are the records sorted?



3. Create a query that you might use with this database. 
(For example: To find the city where a particular NAF Academy Advisory Board member lives.)

4. What is the key for your query? 

Student Resource 7.8

Reading: Introduction to Databases
A Short History of Databases and Their Importance
For as long as humans have had things, they have needed to keep track of them. Different cultures have used different ways to store information. The Sumerians kept track of things with symbols on clay tablets. Ancient Egyptians used papyrus scrolls. The ancient Chinese used paper made from mulberries, and the Inca used knots in colored strings. Our society’s contribution to how information is stored is the computer database. 
Computer storage is the natural successor to paper-based data storage. Computers have several advantages over paper, such as speed in retrieving information and how easy they make it to copy data. 
A Database vs. a Database Management System

The term database refers to the software and physical methods of data storage (i.e., how a computer stores information in memory and on the hard drive). Information in databases is arranged as a table with columns and rows. In database terms, a column is a field and rows are records. For example, each song in an iTunes database is a record, and each piece of information (title, artist, or album) is a separate column, or field.
When a user needs information, she asks a question, or query, of the database, usually in a special language like SQL. The database and the software it uses to talk to the query language is called a Database Management System (DBMS).
Modern Database Management Systems and Their Features

Today, databases are used nearly everywhere. Any time we buy something online or use an email program, databases organize the data’s storage and retrieval. There are several ways a database can store and retrieve information. The most common of these is known as the relational model. Huge Oracle databases use this model, as do desktop applications like Microsoft Access and FileMaker.

Some of the main characteristics of relational databases are:
· Data storage. Data is stored as tables. Multiple tables have relationships to one another. For example, the iTunes Store has a record of your customer information in its table named Customer_Info; this record includes your name and billing details. The iTunes Store also has a record for each of your purchases, which could be stored in a table named Sold_Songs. It would hold the song information along with your name. Your name is a relationship between the Customer_Info and the Sold_Songs tables. 

· Data interaction. Questions can be asked of databases using queries written in special languages, like SQL. For example, if an employee of the iTunes Store wanted to know about all of your purchases and your billing information, he could query the database to search for your name, purchases, and billing details. The query would search in the Customer_Info table and the Sold_Songs table for your name. It would pull purchase information from Sold_Songs and get your billing information from the Customer_Info table. Because it is the common field in each table, your name is known as the key.

The example on the following page shows a database table with fields and records labeled. If a query were run to find the address and purchases for a particular customer name, the customer’s name would be the key.
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· Indexing. Both desktop databases and enterprise-level databases used by large companies use indexing to make them faster. Indexing is a sorted list of fields with pointers to rows. This is like an index at the back of a book.

· Security. Modern databases encrypt their contents and outline procedures to prevent unauthorized activity.

· Forms and reports. Users enter information into databases using forms. Desktop databases in particular try to make the form creation process user friendly. A report shows the results of a query and can be formatted to present the data clearly. For example, if the CEO of Yoyodyne, Inc., wants to see last year’s sales compared to this year’s sales, divided by month, she can use the database to generate a report to show the results in a meaningful format. 

The following image shows a form for entering music data:

[image: image18.png]866 Music Library

srowse F—
wo+n| Music Library
Layour:
form Vie )
T 5
—| wumre e
Record: Artist: racl
. s
Labe: Ao | 2
e 3
3
oned | voar Recordea: :
Wedtums :
;
s
s
Genre: Biues Regase %
Clocsial Rap B
Country Western  Rock
Easy Listening Rhythm & Blues -
Heavy Metal Sl i
Sare Wortd Music 1
New Wave Other i
Pop. 16
= s o
omments N
Totat

100/ Sl Browse




· Multi-user efficiency and optimization. Although it is possible to design and use a database just for and by yourself, databases generally have many users accessing them. Desktop databases don’t scale very well beyond a small number of users, but massive databases can be accessed by millions of users per hour. 
Student Resource 7.9

Worksheet: Creating an Address Database
The Mail Merge feature in Microsoft Word allows you to customize large mailings. For example, you can use Mail Merge to create a form letter and then insert personalized address information or messages on each copy that you generate or print. In this activity, you will be creating a form letter to send to colleges you might be interested in attending. You can ask them to send you information that will help you decide whether the college is a good choice for you.
Overview of Mail Merge 
Mail Merge allows you to create letters, envelopes, labels, directories, and mass emails in a fraction of the time it would take to prepare them individually. You can create a document that contains repetitious information (an invitation with the same key coordinates for all invitees), and then include a space for information that varies (name, address, greeting, etc.). In essence, you prepare a form document with placeholders, and this document gets combined with a Mail Merge database that contains a list of variant information to produce a group of customized documents. 
Try It Yourself

Look on the Internet and find the postal addresses of at least four colleges that you might be interested in attending. Write down the addresses so that you can put them in your Mail Merge database. Next, follow the procedure below to create a form letter to send to each of the colleges asking for more information. Finally, you can print your letters, and they will be ready for mailing!

1. Open a new, blank document in Word.
2. On the Tools menu, select Letters and Mailings ( Mail Merge Wizard.

3. In the panel that displays on the right, select Letters and then click “Next: Select documents” at the bottom of the panel.

4. In the “Select starting document” panel, choose “Use the current document.” 

5. Save this file, which will be used as the “main” document or form letter.

6. At the bottom of the right panel, click “Next: Select recipients.”
7. Under “Select recipients” choose “Type a new list.” Then click “Create…” to create a data source file with address information for your colleges. 
8. Enter your addresses; note that you input the information into the database with one field in each box. Put the college name in the “Company Name” field for each entry. That way you can personalize your letter to include the college’s name in the text. 

Click the New Entry button each time you want to add a new entry. When you have added all of your entries (you should have at least four records), click Close and save the file.
9. Your new database displays. Check and make sure that all of the entries are correct. Edit any that aren’t correct, and then click OK.
10. At the bottom of the panel, click “Next: Write your letter” to go back to your “main” document. 

11. Type a short form letter asking for information about the colleges you are writing to. Place your cursor where you want to place the college’s address, and select “Address block” to insert the address. In the same way, place your cursor at points in the letter where you want to insert the name of the college, and select Items in the panel. This will display a list of the fields in your database, and you can select “Company name.” See the exemplar on the next page for a sample of what your letter might look like before the database fields are merged in. 
12. Check the spelling and grammar of your form letter.
13. Click “Next: Preview your letters” in the panel to see what your letters will look like when the database information is merged in.

14. Click “Next: Complete the merge” to prepare your letters for printing.
15. Click Print in the panel, and then proceed to print your letters. 

16. Close all open documents, saving all changes.

Congratulations! You have succeeded in using a database.

A quality form letter meets the following criteria:
· The form letter has Mail Merge fields and requests information about colleges. 
· The letter drafted is professional in tone and subject.
· The letter features merged addresses from a Mail Merge list.
· Addresses are complete (number, street name, city, state, and ZIP are all included).
· The letter includes merged data (probably the name of the college).
· The letter features good grammar and correct spelling.
Exemplar: Mail Merge Form Letter

Your name

Your address


<<_COMPANY_

>><<_STREET1_

>><<_STREET2_

>><<_CITY_>><<, _STATE_>><< _POSTAL_>>" \l 1033 \c 0 \e "" 
««AddressBlock»»










June 24, 2008

Dear «Company_Name» Recruiter,

I am a freshman in high school and I am just starting to collect information about colleges that interest me. I am interested in «Company_Name» because ___________________________________ ___________________________________________________________________________ ___________________________________________________________________________.

I am hoping to major in _________________________________. Can you please send me any information that would help me to prepare for a major in this field, or help me to learn more about «Company_Name»?
Thank you very much for your help. I look forward to reading more about your school and perhaps visiting your campus in the near future.

Sincerely, 

___________________

Student Resource 7.10

Project Planner Page 3: 
Planning a Dream Computer System
Group members’ names: _____________________________________________________________

Main use for computer: ________________________________________________________ 

This is the third page of the project planner you’ll use to help plan your group’s computer. Later, you will add things like the operating system, Internet access, and other software you need for activities like creating graphics or listening to music. 

Answer the questions below to identify and plan the productivity applications you would purchase and install on your dream computer system. List the factors (such as ease of use, compatibility, features, etc.) that you will keep in mind while outfitting the system. Don’t forget to think about your computer’s stated purpose when you are making these choices.  

When telling about the applications you would choose, be as specific as you can, but don’t worry about the exact version you might buy. For example, if you know you will need a database application but have not yet chosen which, you can come back to this later and add that information as your other plans for the system take shape.

What this computer will be used for:

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________
_____________________________________________________________________________
Software we need to buy: 
(Be as specific as you can, but a general answer like “database” is fine for now.)

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________
_____________________________________________________________________________
____________________________________________________________________________
_____________________________________________________________________________

Why did you make these choices? 

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

Additional notes:

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________
_____________________________________________________________________________
_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________
_____________________________________________________________________________
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